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Getting Started 
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Installation is Easy! 
 

Open The Download .ZIP File Folder 

OR Extract the Template Files from 

the  ZIP Download File 

 

Locate the compressed (zip) template folder that you just downloaded. 

On many PCs, you must extract the contents of the .ZIP file folder to a 

location of your choice on your computer, such as the desktop. This will 

allow you to access the template files, documentation, links and other 

materials. 

Newer PCs and Macs will allow you to open and work out of the .ZIP file 

without extracting the contents. The .ZIP file will appear as a standard 

folder on your PC or Mac, containing the template and related files. 

 
 

Install the Fonts 

 

 

 

Inside the template folder, locate the “Fonts (INSTALL FIRST)” folder and 

open it. Install all of the included fonts by opening and installing each one 

individually. 

(Alternately, you may drag the font files to your PC’s “C:\Windows\Fonts” 

folder or to your Macintosh’s “Font-Book”.) 

 
 

 

Open the Template file 

for your version of MS Word. 
 

Open the folder containing the Word template. 

For Word 2007 and newer, open the template file with the Microsoft 

Word .DOCX extension. 

 

Note: The template will contain sample chapters and content to help you 

get started. You may overwrite or remove this content as needed. 
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Template Layout Overview 
 
 

 

Chapter Heads: Unique and stylized designs 

are made simple though the use of pre-set 

Styles for chapter numbers and titles. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pro Design: Drop caps, 

dingbats and Styles for small 

-caps text are included with 

select templates. 

Body Text: Text is controlled by 

several author selectable format- 

ting Styles that are designed to 

give you a professional layout with- 

out any guesswork. Choose from 

normal, non-indented, italicized 

and capitalized text to make your 

artisan work stand out. 
 

 

 

Pagination: Page numbering is 

controlled with section breaks to 

ensure that every segment begins 

on the correct page. (Most often on 

recto, or “odd” pages.) 
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Book Construction Basics for Print 
 
 
 

Chapters Start on Recto Pages: 

Books can have blank pages too. The 

vast majority of books follow the 

industry standard of chapter openers 

starting on a Recto, or right-hand (odd) 

page. Often, the prior chapter ends on 

an odd-numbered page. When this hap- 

pens, it is customary to make the back 

of that page blank, to allow the next 

chapter to start on the correct page. 

This is also true for many front matter 

pages like dedications and quotations. 

 

 

 

 

 

 

 

 

 

 

 
Verso (Left) 

Even Number 

 

 

 

 

 

 

 

 

 

 

 

Recto (Right) 

Odd Number 

 

 

 

 

Books have Gutter Margins: 

Books have bindings in the center to 

hold all of the pages together. These 

bindings cause the pages to roll inward 

toward the center in what is called a 

gutter. Extra page spacing, or gutter 

margins, are required on the inside 

edges of the page to account for the 

gutter. 

Even pages will have larger margins on 

the right side, and odd pages will have 

larger margins on the left side to allow 

the page to appear centered when 

bound in book form. 

 

 

 

 

 

 

 

 

 

 

 

 
Even Page 

Right Gutter 

 

 

 

 

 

 

 

 

 

 

 
 

Odd Page 

Left Gutter 
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Book Construction Basics for eBooks 
 

 

Most Formatting is Discarded 

during eBook Conversion: 

eBooks and eReader platforms are still 

in their infancy. Although newer eRead- 

ers may incorporate some font embed- 

ding, drop-caps, and fixed layout, 

eBooks are still dominated by minimal 

text layout options. As such, templates 

are built with formatting that is most 

common across the multitude of 

eReader platforms, and omit format 

features that most often malfunction, 

like fancy fonts and fixed layout. 

 
 

 

 

eBooks Have No Page Sizes: 

eBook formats will not have a set page 

size. Word does require a page size for 

the document, but once the file has 

been converted to an eBook, the 

margins, gutters, and spacing will be 

ignored by eReader devices. 

 
Further, Section Breaks get converted 

by eReader platforms into page-breaks 

automatically. This removes blank pages 

automatically from your finished eBook 

file. 



 

Key Concepts & Quick Start Tips 
 

Use Show/Hide to See Formatting Markup 
 

Word’s Show/Hide command will reveal hidden formatting 

marks in your template, like section breaks, tabs, & carriage re- 

turns. Turning on this mode to see these marks will make for- 

matting much easier. This is essential for adding and removing Sec- 

tion Breaks and making sure you have the proper spacing and para- 

graph alignment in your book. We advise turning this mode on dur- 

ing the entire process of formatting your book using the template. 

 

Use Styles for Proper Layout 
 

Every formatted section of the book template has a corresponding 

Style in Word that is pre-configured for the best layout results. You 

can utilize these Styles to quickly format new chapters. After pasting 

in your manuscript text, always apply the proper Word Style to 

ensure proper layout. There are Styles for virtually every formatting 

scenario in the template, from chapter names and numbers, to the 

text on the title page and copyright page text. 

 
 

Use Odd Page Section Breaks at the End 

of Chapters and other Sections 

 

Books have special page formatting requirements that call for 

chapters to begin on the right-hand, or recto page. The first page 

of each chapter of your book must start on an odd-page to meet 

this formatting specification. After the last paragraph of each 

chapter, insert an odd-page section break to ensure that the next 

chapter begins where it should. 

Section Breaks can also be used to add additional pages to the 

front-matter of your book. Simply insert a new Section Break (Odd 

Page) after the dedication or quotation page in the template and 

the next page will be a blank recto page, ready for text. 
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Key Concepts & Quick Start Tips (cont) 

Drop Caps Can be  Easily Removed and Added 
 

Some templates feature a drop cap letter at the chapter opening. 

Word makes it easy to insert a drop cap (or raised cap) as needed. 

When copying over the text of your manuscript to the template, you 

should delete the template drop cap and re-create it once your text 

copy has been completed. 

 

Copy/Paste Merge Formatting Text where 

Possible. 
 

 

The templates utilize preformatted Styles to control the layout of 

the text. When pasting in new text from your manuscript, we ad- 

vise pasting with “Merge Formatting”, or pasting with “Keep Text 

Only” to prevent your original text font and style from transferring 

to the template. 

Some versions of Word do not have this paste function, so the 

standard paste will have to be used. You may utilize the styles in 

Word to stylize and format the text after pasting. 

 

 

 

Page Numbers are Pre-Configured by Section 
 

Section Breaks signal to Word that the template is beginning a new 

chapter, front-matter page, or back-matter page. The template’s 

built-in samples have pre-defined page numbering for each of these 

sections, with some containing page numbers, some pages that 

omit page numbers and others have Roman numerals. It is im- 

portant to keep this in mind when creating new sections, especially 

chapters, to  preserve the page numbering scheme of the book. 

 
 

Tip: More advanced layout and formatting instructions can be found in the 

“Layout Essentials” section of this guide. 
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Transfer Your 

Manuscript & 

Format It 



 

Transfer Your Content 
 

Transfer your Manuscript to the Template with Ease 

Transferring your manuscript is as easy as using copy and paste.  Our pre-formatted 

templates come with three sample chapters that you can overwrite with your own 

text and replicate as needed. 

Open your manuscript in Word and highlight the chapter text you want to move to 

the template. Use the “Copy” command on the highlighted text. Next, open the tem- 

plate in Word. Highlight the sample text in chapter 1 and then “paste” the copied text 

over it. Re-highlight the new chapter text and apply “Body” Styles as need to auto- 

matically layout the chapter. 

Note: We recommend copying over each chapter,one  at  a  time,  to  ensure  uniform 

text transfer and formatting. (Copy/Pasting the entire book at one time is 

recommended only for advanced/experienced users.) 

Note: If your book has a preface or introduction, replace the text in the sample 

chapter 1 with the preface or introduction. Then paste your chapter 1 over the tem- 

plate’s sample chapter 2. This will preserve all page number formatting. 

Always start by overwriting the chapter 1 sample, to ensure the page numbers 

and running heads replicate correctly. 
 

 

 

1 
 

 

 

 

 
 

Highlight the chapter text in 

your manuscript. Use Word’s Copy 

function to copy the text to the 

computer’s “clipboard”. 
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Transfer Your Content 

Highlight the chapter text in the template 2 
that you wish to overwrite or delete. 

 
Be careful not to highlight the chapter name, 

number, or the hidden “Section Break” mark- 

up at the end of the chapter. 

 
We recommend using “Show/Hide” to view the 

hidden markup during this step, as outlined in 

the “Layout Essentials” section of this manual. 
 

 

Paste the chapter text in the template that 

you wish to overwrite or add. If you have the 

option, use Paste “Merge Formatting”, or 3 
Paste “Keep Text Only”. 

After pasting the text, highlight and reapply 

Styles for the text you entered, as well as apply 

the “Drop Cap” at the beginning of the para- 

graph. 

 

Chapters always end with a single “Section 

Break (Odd Page)” after the last paragraph, to 

ensure that the next chapter starts on an odd 

(right-hand) page. 

You may add this from the “Page Layout” tab in 

Word, under the “Page Setup”, “Breaks” drop- 

down menu. Use “Show/Hide” to see this 4 
normally hidden markup document. 
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Inserting More Chapters & Chapter Headers 
 
 
 
 

 

Inserting New Chapters are easy to do. Simply add a new Section Break 

(Odd Page) at the end of the last sample chapter and begin formatting. 

 

Insert a Section Break (Odd Page) 

after the last paragraph of the last 

chapter. Click the Breaks drop down 

on the Page Layout tab. Click Odd 

Page from the menu to insert the 

break. 
 

 

Tip: This will create a new, odd- 

numbered blank page. You my 

optionally use a Section Break (Next 

Page) if you do not want blank pages 

in your finished book file. You only 

need one section break per chapter. 

 

Type the new chapter header text for 

the chapter number and/or name. 

 

Highlight the new chapter header text 

and apply the appropriate styles. 
 

Tip: Optionally, copy and paste the 

pre-formatted chapter header from 

the previous chapter and change it. 
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Inserting More Chapters & Chapter Headers (cont) 
 
 
 
 
 
 
 
 
 
 

Tip: If your chapter name or title 

name exceeds the width of the page, 

Word will automatically hyphenate 

the title and break it into two lines. 

 
To manually break the line in the 

middle, use the carriage return 

(SHIFT+ENTER). This will move the 

following text to the next line 

without hyphenation. 
 

 

 

 

 

Tip: Templates with a Table of Con- 

tents (TOC) automatically generate 

the TOC using text that is formatted 

with specific styles. Typically, the 

Chapter Name/Title, Back Matter Title, 

& Subhead A style formatted text will 

appear in the TOC when updated. 
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Drop Caps  
 
 
 
 
 
 
 

 

Drop caps are used on the first paragraph of select template designs. 

Creating a drop cap is a three step process that is easy to complete. 

 

 

 
 

Highlight the first character of the 

chapter’s opening paragraph. 
 

 

 

 

 

 

 
 

Select Drop Cap from the insert tab, 

“Text” section, and choose “Dropped”. 
 

 

 

 

 

 

Tip: Optionally, select Drop Cap 

Properties/options to adjust the size 

of the drop cap to the number of lines 

that you wish the drop cap to occupy. 
 

 

 

Tip: Raised Caps are an option on some templates. To create a raised cap, 

highlight the first character of the paragraph and select the raised cap style. 
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Section Breaks 
 
 
 
 
 

 

Section Breaks are used after the last paragraph of a chapter. Inserting a section 

break assures that the next chapter or front matter page starts in the correct place. 

Most section breaks will be for “odd” , or verso pages. Chapters should always start on 

an odd-page, so be sure that every chapter ends in a “Section Break (Odd Page)”. 

 

 

End the last paragraph of chapter or 

page text with an“ENTER” or pilcrow. 
 

 

 

 
 

Select the “Breaks” dropdown 

from the “Page Layout” tab, “Page Set- 

up” section. 
 

 

 

 

 

Select Odd Page to insert an Odd 

Page Section Break. 

If you require a next page section 

break, choose it from the menu. 
 

 

 

Tip: Be sure that you only have a single Section Break (Odd page), and not 

two in a row, as this can throw off page numbering in your final file. 

The Sample chapters in the template include a Section Break. 



17 @Copyright 2018 – BookDesignTemplates.com – All rights reserved.  

Headers and Footers (Print Only) 
 
 
 
 
 
 

 

Running heads and page numbers are included in your template and are designed to 

automatically paginate correctly in each chapter without author intervention. In most templates, 

the front-matter and first page of the chapter will omit the running head. The book title and 

author will only appear on subsequent chapter pages, per industry standards. 

You must modify the running heads to include both the author’s name and book title. All 

running heads are linked throughout the book. By changing the author’s name and book title 

on the first chapter’s running heads, the change will propagate throughout the entire template 

automatically, saving you time and effort. 

Note: eBook templates do not utilize running heads or page numbers. If present, they will be 

removed during eBook conversion automatically. 

 

 

 

Navigate to the second page of the 

first chapter of your book. 
 

 

Double click the header area, or 

choose Header / Edit Header from the 

Insert tab to edit the header. 
 
 

Change the header by over-typing the 

text already in place. 
 

 

When finished, click “Close Header and 

Footer” on the title bar. 
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Table of Contents  
 
 
 
 
 
 
 
 
 
 

The Table of Contents (TOC) included with non-fiction templates is pre-formatted to 

match the interior style of your book, and is designed to automatically update itself with the 

push of a button, so there is no need to manually change the table. 

The table is generated from the chapter titles and subheadings you have in your book, based 

upon the styles used to format them. Once you have completed the copy of your manuscript to 

the template, and applied the Chapter Title, Subhead, and Back Matter Title Styles, the table’s 

update procedure will automatically generate the TOC using the tagged titles and subheads. 

The TOC has 2 levels of indention, based upon the Style used: 

First Level: Text Formatted with styles: Chapter Title, Back Matter Title 

Second Level: Text Formatted with style: A Subhead (Level 1) 

Note: The Table of Contents Title , Title (Title Page), and Subtitle (Title Page) Styles do not 

appear in the TOC. 

 

Update the TOC by right-clicking the 

text of the TOC and choosing “Update 

Field” from the menu. 
 

 

Choose “Update entire table” by click- 

ing the radio-button next to it. 

Click “OK” to update the TOC. 
 

 
 

Tip: Do not type over any text in the TOC, this may disable it’s ability to 

update automatically. Instead, update your chapter titles & subheads. 
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Chapter Name Header (Print Only) 
 
 
 
 
 
 

Chapter name headers are sometimes required to meet an author’s design or layout goals. 

By default, our templates come configured with the author’s name as the standard running head 

on even pages of the book. You can convert the author name running head to a customizable 

chapter name by following these easy steps. 

Note: These steps should only be completed after all chapters have been formatted in the manu- 

script and all pages are included. This step should be a “last step” before going to print, as 

un-linking the headers in the template may interfere with proper page numbering if performed 

before all pages are in the book file. 
 

Complete the process of transferring 

your manuscript to the template and 

complete all other formatting. 
 

Open the even page header in the first 

chapter by double clicking it. 
 

Change the author name to the title of 

the first chapter then Close. 
 

Open the even page header in the 

next chapter by double clicking it. 
 

Unselect the Link to Previous button 

in the navigation section . 
 

Change the author name to the title of 

the chapter then Close. 
 

Repeat for all subsequent chapters. 
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Page Numbering Sequence or Style (Print Only) 

Occasionally, you may wish to change the page number sequence or style. Word utilizes a simple 

system to keep track of page numbering, with the option to “continue” a sequence from a previous 

section, or to start the numbering at a specific page number in the section. You can easily manage 

page numbering with the steps below. 

 

 
 

Double click the header area, or 

choose Header / Edit Header from 

the Insert tab to edit the header. 
 

 
 

Highlight the page number in the 

header, or footer and right-click it to 

bring up menu. 

Choose “Format Page Numbers”. 
 

 

 
 

Choose “Continue from previous 

section” to have the numbering 

continue the sequence from a 

previous section or chapter. 

Choose “Start at:” and enter a page 

number if you wish to re-start the 

numbering sequence. 

You may also change the numbering 

style to Roman numerals here. 
 

 

When finished, click “Close Header 

and Footer” on the title bar. 
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Formatting Chapters to be Contiguous 

The templates and our instructions are geared toward producing books with chapters and other title 

pages starting on a recto, or right-hand page, odd page. This produces a well-flowing book with 

expected and consistent breaks between chapters. This also adds blank even pages where needed in 

the book, to maintain a consistent odd-page start for chapter and title pages. 

However, some book project require that all chapters be contiguous, or that the book not contain 

any blank verso, left-hand pages. To do this, you can quickly and easily convert all Section Break (Odd 

Page) formatting marks to Section Break (Next Page) marks, eliminating blank pages caused by 

section breaks, and forcing all chapters to begin on the page immediately following the end of the 

previous chapter. This approach is useful for short story collections or books with many chapters. 
 

Format the book as normal, complet- 

ing the addition of all chapters, with a 

section break at the end of the last 

paragraph of each chapter. 
 
 

Choose “Custom Margins” from the 

Margins drop-down menu on the Page 

Layout tab. 
 

 
 

Click the “Layout” tab. 

Choose “Whole Document” from 

the Apply to drop-down menu. 

Choose “New Page” from the Sec- 

tion start drop-down menu. 

Click “OK” 
 

 
 

All “Section Break (Odd Page)” breaks 

will convert to “Section Break (Next 

Page)” breaks, removing blank pages. 
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Non-Fiction Template 

Feature Formatting 
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Subheads (Non-Fiction) 
 
 
 
 
 
 
 
 
 

 

Subheads are utilized in non-fiction books for a variety of reasons including breaking a 

complex chapter into organized sections and to start or highlight a new idea. There are two 

levels of subheadings included in the template file for ease of organization. Subheads are also 

visible on the Table of Contents as a indented line and page number, organized below the 

chapter titles in the table. This makes subheads a great way to help your readers find what they 

need in your non-fiction book. 

 

 

Highlight the subheading text that 

you wish to format as a subhead. 
 

 

Select the Subhead (Level 1) Style 

from the Style menu. 
 

 

 

 

 

 

 

For a second level subheading, 

Choose the B Subhead (Level 2) style 

from the Style Menu. 
 

 

 

Tip: Typically, only Subhead A will appear in the TOC, though some 

templates, like Poetry Templates, will show all the subheads in the TOC. 
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Quotations (Non-Fiction) 
 
 
 
 
 
 
 
 
 
 
 

Quotations, Extracts and Pull Quotes are utilized to highlight a section of text or an idea 

from a passage of text. The non-fiction templates comes with three styles to choose from to 

property format these sections of text. 

Quotation (Extract No Indent) - The first line of the extract will not have an indention. This style of 

quotation will indent the entire paragraph and center it on the page. 

Quotation (Extract Indented) - The first line of the extract will have an indention. This style of quo- 

tation will indent the entire paragraph and center it on the page. 

Quotation (Pull Quote) - Pull quotes will format with a left side indention, be italicized, and may 

have shading behind the text to set it apart. 

 

 

 

 

Separate the text you wish to format 

as a quotation into its own paragraph. 
 

 

 

Highlight the text that you want to 

format as a quotation style. 
 

 

 

Click the quotation style that you 

would like to apply from the style 

menu to  format the paragraph. 
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Bullet Points and Numbered Lists (Non-Fiction) 
 
 
 
 
 
 
 
 
 
 
 

Bullet Points and Numbered Lists are frequently used tools to summarize ideas or to get 

your main points across to your readers. There are two custom styles for formatting both bullet 

points and numbered lists in the template, formatted to match the layout of the book. 

NOTE: These styles are applied from the Multilevel List menu, instead of the Styles gallery. 
 

 

Create your bullet points or 

numbered list by placing each point 

or item  as a new line of text. 

Then highlight the lines. 
 

 

 

Click Multilevel List drop down from 

the Paragraph section of the Home tab. 
 

 

Click the Bullet Point or Numbered List 

style you wish in the List Styles section. 
 

 

Click the Increase Indent or Decrease 

Indent buttons to align each item on 

the list to its proper level. 



 

Index (Non-Fiction) 
 
 
 
 
 
 

 

The Index functions included in Microsoft Word make it easy to generate a dynamic index for 

your book project. Adding a word or phrase to the index can be completed in a few short steps. 

NOTE: Word will tag your entry with {XE “ “} in the text of the document. These tags are invisible 

in your printed, PDF or eBook final files. 

 

 

Highlight the text you wish to add to 

the book’s index. 
 

 

 

 

 
 

Click Mark Entry, found on the 

References tab in the Index area. 
 

 

 
 

Adjust entry text to your preference 

and add cross-references if needed. 

You may also bold or italicize the text. 

 
Click Mark or Mark All to add the text 

to the index at the end of the book. 
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Updating the Index (Non-Fiction) 
 
 
 
 
 
 
 
 

Updating The Index upon completion of the book is a simple task that takes only 

a few seconds to finish. Once you have all of your index entries finalized in the 

body of the work, you may update the index to dynamically generate entries. 
 

Click Show/Hide to expose the 

formatting markup for the document 

in the index section at the end of the 

template. 
 
 

Click the text in the sample index and 

Right Click to bring up the menu. 

Click Update Field. 
 

 
 

Tip: If an extra Section Break 

(Continuous) appears and moves the 

index text down a page, you may correct 

the issue by adding a carriage return 

(pilcrow) before the Section Break to pull 

the text up to its proper position. 

Place your cursor behind the Section 

Break and press ENTER. 
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Footnotes (Non-Fiction) 
 
 
 
 
 
 
 

 

Footnotes can be a valuable way to reference material in your book project. The notation function- 

ality in Word allows you to create a virtually endless number of references that  automatically update 

at the page bottom. 

 

Highlight the text that you wish to 

reference in the footnote. 
 
 

Click Insert Footnote in the Footnotes 

section of the References tab on the 

toolbar. This will add a superscript 

Arabic numeral next to the word. 
 

Inserting a Footnote will automati- 

cally add a new Arabic numeral to the 

bottom of the page, matching the 

one next to the text you highlighted 

and will allow you to add an entry. 
 

 

Tip: For eBook formatted files, all footnotes and endnotes will automatical- 

ly become hyperlinked to the note at the back of the document upon 

conversion to eBook format. The in-text citation will appear as a superscript 

number that is “clickable” on the eReader device’s screen. Once clicked, the 

note will appear for the reader. 
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Footnotes (Non-Fiction) 
 
 
 
 
 
 
 

Endnotes can be a valuable way to reference material in your book project. The notation function- 

ality in Word allows you to create a virtually endless number of references that automatically update 

and in the endnote section at the chapter’s end. Endnotes will display after the Section Break (Odd 

Page), and should be added as a last step, after the entire manuscript is formatted in the template. 

 

 

Highlight the text that you wish to 

reference in the endnote. 
 

 

Click Insert Endnote in the Footnotes 

section of the References tab on the 

toolbar. 
 
 

Inserting an endnote will automati- 

cally add a new Arabic numeral to the 

Endnote section, at the end of the 

chapter, after the Section Break and 

allow you to add an entry. 
 
 

Tip: Some versions of Word have a bug that causes the document to scroll 

to the last page when you insert an endnote for the first time. This will 

require you to scroll back up to the end of the chapter you were working on 

to enter the endnote. 



 

Citations (Non-Fiction) 
 
 
 
 
 
 

 

The Bibliography and Citation system in Word makes adding references in both MLA and 

APA format an easy task. Simply mark an entry you wish to cite, insert a citation, and then fill out 

the easy form to add entries. Word goes one step further by automatically cataloging your 

sources in a handy list for easy use in multiple locations. 

NOTE:  Bibliography and Citation functions are not supported in .DOC formatted files. 
 

Highlight the text you wish to add to 

the book’s bibliography. 
 

Click Insert Citation, found on the 

References tab in the Citations & Bibli- 

ography area. Choose from an existing 

source or Add New Source. 
 
 

Tip: You may choose MLA or APA from 

the Style dropdown to set the default 

for citation formatting. 
 
 

If you are adding a new source, a form 

will appear that will  allow you to 

enter your source’s information. 

This info will be added to the 

bibliography when you update it. 
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Updating the Bibliography (Non-Fiction) 
 
 
 
 
 
 

 

Updating the bibliography upon completion of the book is a simple task that takes only a few 

seconds to finish. Once you have all of your citations finalized in the body of the work, you may 

update the bibliography to dynamically generate entries, using the sources you have created 

through the citation process. 

NOTE: Bibliography and Citation functions are not supported in .DOC formatted files. 
 

 

 

Navigate to the bibliography section 

at the end of the book. 
 

 

 
 

Click the text in the sample 

bibliography and right click to bring 

up the menu. 

 
Click Update Field. 

 

 

 

 

Tip: You may manage your sources 

using the Manage Sources button in 

the Citations & Bibliography section 

of the References tab. 
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Children’s Template 

Feature Formatting 
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Illustrated Pages 

Illustrated Pages in children’s book templates are designed to allow easy inclusion of an 

image and some accompanying text on the page. To create an illustrated page, you must first 

start with a blank page. Counter to the typical book template, you will utilize Page Breaks, instead 

of the Section Break (Odd Page) in most areas of the children’s book template, to allow finer 

control of each page in the book. 

 

Insert a Page Break at the end of the 

current page, to create a new blank 

page in the template. 
 

 

 

Insert an image onto the new blank 

page first. (Go to the insert tab, then 

select  picture) 
 

Resize the image as needed by using 

the drag boxes on the corners or side 

of the image file. 

 

Press Enter to assure that the image is 

in its own paragraph, as in the 

example shown. 

 

Add Body Text below the image and 

format it using the styles included. 

 
Insert a Page Break to move to the 

next page of the template. 

 
SPECIAL NOTE:  The eBook 

-only illustrated children’s 

book has a special set of 

instructions, found at the 

end of this chapter. 
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Full Bleed Illustrated Pages 

Illustrated Pages with a “Full Bleed” require a few extra steps to ensure that they image fills 

the entire page. You must insert an additional Page break to create the page that will come after 

the page with the full bleed image first, as the full bleed image will likely prevent you from insert- 

ing a new page otherwise. You will also need to utilize the text-box feature in word if you wish to 

place text over the image. 

 

 

Insert two Page Breaks at the end of 

the current page, to create 2 new 

blank pages in the template. 

Navigate to the first blank page. 
 

 

 

 

 

Insert an image onto the new blank 

page first. (Go to the insert tab, then 

select  picture) 
 

 

Change the Wrap Text settings for 

the image by right-clicking the image 

and selecting Wrap Text from the 

menu. Choose “Behind Text” to make 

the image unlock so that it can be ex- 

panded larger than the page. 
 

 

 
 

Tip: Be sure that your printing company will accept documents with a full 

bleed image. Some printers will not accept a full-bleed and place a border of 

white space around your image. 
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Full Bleed Illustrated Pages (Cont) 
 
 
 

Expand the image file, using the drag 

boxes, until it is larger than the page. 

You can reposition the image as need- 

ed to center it as you wish. 
 

 

 

TIP: After resizing the image, Word 

may move the image up or down on 

the page, or cut-off part of the image. 

You must click on the image and  

drag it to the desired place or page 

to get the image to appear correctly. 
 

 

 

Insert a text box over the image if 

you wish to add text to page. 

On the Insert Tab, select the “Text 

Box” drop down from the Text sec- 

tion. Choose “Draw Text Box” from 

the menu. Draw the box where you 

would like the text to appear. 
 

 

TIP: Illustrated Book templates have a 

special style (Body (Text Box)) that is 

pre-formatted to look great in a text 

box where the text is typically larger. 



 

Full Bleed Illustrated Pages (Cont) 
 
 

Change the text box to have no 

border and a transparent background 

to allow the text to seamlessly blend 

in with the full-bleed image. 
 

 

 

Click on the text box. Then select the 

“Format” tab under drawing tools. 

Choose “Shape Fill” and “No Fill” from 

the drop down. (Note: This item may 

also be found on the Format Tab un- 

der “Text Box Style” in some versions 

of Microsoft Word. 
 

 

Click on the text box. Then select the 

“Format” tab under drawing tools. 

Choose “Shape Outline” and “No Out- 

line” from the drop down. (Note: This 

item may also be found on the For- 

mat Tab under “Text Box Style” in 

some versions of Microsoft Word. 
 

 

SPECIAL NOTE: Documents containing text boxes require that the PDF be 

created in NON-PDF/A Format, counter to the instructions in the “Getting 

Ready for Print” section of this guide. PDF/A formats will cause the text box 

to print with a white background, instead of being transparent. 
 

36 @Copyright 2018 – BookDesignTemplates.com – All rights reserved. 



 

eBook-Illustrated Images 
eBook- Illustrated Pages require a precision layout and underlying structure to assure that 

images appear correctly on a multitude of eReader devices, and the corresponding text stays with 

the image as intended. Different eReader device models may vary greatly in the number of pixels 

available for use on the physical screen. We have assessed the most common models and have 

created our eBook template to accommodate the widest range of devices for image sizing, 

resolution, and text layout functionality. 

 

The eBook- Children’s Template 

utilizes a specially formatted table on 

each page of the body of the book to 

assure that images and text appear 

together on the  eReader screen. 
 

The top table cell contains the image 

file, while the bottom cell contains the 

formatted text block. 

 

New pages may be added by copying 

this table and the included “page 

break” , and  pasting it on a new page. 
 

 

TIP: If the table lines are hidden, you 

may enable a special “View Gridlines” 

mode by clicking on the image or text 

in the table. Then click the “Design” 

tab in the “Table Tools” ribbon menu. 

Select the “Borders” drop down and 

click “View Gridlines.”These lines will 

remain invisible in the finished eBook. 
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eBook-Illustrated Images (Cont) 

Delete the sample image in the table 

by clicking on it and pressing the 

delete or backspace key on your 

keyboard. 

 

The empty table cell will have a place- 

holder marker icon. 

 

Place your cursor in the cell, before the 

place-holder marker icon 

 

Select Picture from the insert tab. Your 

image will appear in the table. 
 

Click the Picture to highlight it, then 

apply the “Image Cell (Centered)” Style, 

from the Style Gallery. 

 

Image Size Requirements. We have created a table below with the graphical image size 

requirements for the template to achieve the best results. Images should be a maximum of 

300 pixels wide, and 400 pixels high, or smaller. To properly display in Word, the image should be 

set to 72 ppi / dpi (pixels per inch / dots per inch) or 28.346 dpc (dots per centimeter). 
 

 

TIP: For best results on Kindle, save the final file in “WebPage / Filtered (HTML)” format, and 

compress the HTML file and the FILES folder into a .ZIP file for upload to Amazon KDP. 

Graphical (72 ppi) 

Pixels Wide Pixels High Lines of Text 

300 400 2 

300 350 4 

300 300 6 

300 200 8 / Title Page 

 

Adapted from Print 

Inch (72.0 dpi) Metric (28.346 dpc) 

4.167" x 5.556" 105mm x 141mm 

4.167" x 4.861" 105mm x 123mm 

4.167" x 4.167" 105mm x 105mm 

4.167” x 2.778” 105mm x 70mm 
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Using Styles & 

Included Style List 
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Looking Professional with Styles 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Styles are pre-configured formatting specifications that control typography. 

Here, there are two different Styles utilized. The “Title” style sets the book title 

text to a large font and centers it. The “Subtitle” style then formats the book’s 

subtitle to be smaller, and also centered on the page. 

 

Format a Page with Styles 

Styles are a valuable tool for uniformly formatting text within a document. Each 

Style is a pre-configured command that formats the text you highlight in a specific 

way. Styles can control  everything  from  the  font  size  and  position,  to  the  

detailed paragraph typography necessary to present a properly laid out book page. 

There are a number of template Styles included to format your book correctly. 

Styles are easy to use. Highlight a section text that you want to format and then 

choose the Style you want to use from the Word Home tab in the Styles section. The 

text will automatically format to the presets in the pre-defined Style. 

 

Tip: Styles are a critical component of what makes the template’s formatting work. 

Virtually every formatting feature has a corresponding style to make layout simple. 
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Template Style Guide  
 
 

Title Page 
 

Title (Typically Large, Centered) 

 

Subtitle (Typically Medium, Centered) 
 

Author Name (Medium, Centered) 
 

Pub House (Small, Expanded, Centered) 
 

Pub Address (Small, Centered, Caps) 
 

 

 

 

 

 

 

Copyright Page 
 

Copyright (Small, Left Aligned) 
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Template Style Guide  
 
 
 

Dedication & Quotation Pages 
 

Page Space (Blank/White, Tall, Centered) 

 

Body (Centered Italic) (Medium, 

Centered, Italicized) 
 

Body (Centered) (Medium, Centered ) 
 

Body (Small Caps) (Medium, Centered ) 
 

 

 

 

 

 

 

 
 

Chapter Title Page 
 

Chapter Number (Customized) 

 

Chapter Title (Customized ) 
 

Body (Normal) (Indented, Justified) 
 

Body (Small Caps) (Capitalized) 
 
 

Body (No Indent) (Non-indented, 



 

Template Style Guide  
 
 
 

Author Page 
 

Body (Centered) (Small, Centered) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

About the Included Styles 

The Styles listed here are typically included with each template and are specifically 

formatted to meet the design goals of that template. The examples shown are for 

reference only. Template specific or custom Styles may also be included with specific 

templates to meet a design or layout goal, and are not included on this list of Styles. 

The next few pages feature non-fiction template specific styles. 
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Template Style Guide 
 
 
 

Table of Contents 
 

Table of Contents Title (Centered) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Index & Back-Matter 
 

Back Matter Heading (Centered) 
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Template Style Guide (Non-Fiction) 
 
 

Extracts & Pull Quotes 
 

Quotation (Extract No Indent) 

(Mirror Indented Paragraph, Non-indented 

First Line of Text) 
 

Quotation (Extract ) 

(Mirror Indented Paragraph, Indented First 

Line of Text) 
 
 

Quotation (Pull Quote) 

(Left Indented Paragraph, Non-indented 

First Line of Text, Italic, Shaded) 

 

Subheads 
 

A Subhead (Level 1) (Centered, 

1 Indention level on the Table of Contents) 
 

 
 

B Subhead (Level 2) (Centered,) 
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Template Style Guide (Non-Fiction) 
 

 

Bullet Points & Numbering 

Numbered List (Template ) 

(0.25” Tab Spacing, Body Fonts) 
 
 

Bullet Points (Template) 

(0.25” Tab Spacing, Body Fonts) 
 

 

 

 

 

 

 

 

Tip: The bullet point and numbered 

list styles do not appear in the Word 

Styles gallery or list. 

 
To access the bullet and numbered 

list style, you must select from the 

Multilevel List menu on the 

Paragraph section of the Home tab. 

 
The bullet point and numbered List 

styles will be in the List Styles sec- 

tion of the drop down. 
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Template Style Guide (Children’s Only) 
 
 

Half Title Page 
 
 

Half Title 

(Centered, Large) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Raised Caps 
 

Raised Cap 

(Single Character, Larger) 



48 @Copyright 2018 – BookDesignTemplates.com – All rights reserved.  

Template Style Guide (Children’s Only) 
 
 

Illustrated Pages 
 
 

Body (Large) 

(Large Text) 
 

 

 

Body2 (Normal), (Centered), etc. 

(Alternate set of body text in template) 
 

 

 

 
 

Body (Text Box) 

Body2 (Text Box) 

(Special Text formatted for Text Boxes) 
 

 

 

 

 

 

 

 

 

 

Body (Double Spaced) 

Body2 (Double Spaced) 

(Body Normal Text, Double Spaced) 
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Template Style Guide (Poetry Only) 
 
 

Book Part Page 
 
 

Chapter Number 

(Large Text) 
 

 

 

Chapter Preface 

(Narrowed Column, No Indent) 
 

 

 

 

 

 

 

 

 
 

Poetry Subheads 
 

 

A Subhead (Left Aligned Text) 
 

 

 

B Subhead (Centered Text) 
 

 
 

C Subhead (Left Aligned Text, with a 

Narrowed, Center Text Column) 
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Template Style Guide (Poetry Only) 
 
 

Narrow-Left Paragraph Styles 
 

Poetry (Narrow, Rag Right) 

(Narrowed Text Colum on Left of Page, 

Rag-Right Paragraph Text) 
 

Poetry (Narrow, Centered) 

(Narrowed Text Colum on Left of Page, 

Centered Paragraph Text) 
 

Poetry (Narrow, Justified) 

(Narrowed Text Colum on Left of Page, 

Justified Paragraph Text) 

 

 
Tip: Pairs with Subhead A 

 

Narrow-Center Paragraph Styles 
 

Poetry (Centered, Narrow, Rag Right) 

(Narrowed Text Colum on Center of Page, 

Rag-Right Paragraph Text) 
 

Poetry (Centered, Narrow, Centered) 

(Narrowed Text Colum on Center of Page, 

Centered Paragraph Text) 
 

Poetry (Centered, Narrow, Justified) 

(Narrowed Text Colum on Center of Page, 

Justified Paragraph Text) 

 

 

 

Tip: Pairs with Subhead B or C 
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Layout 

Essentials 
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Layout Starts with “Show/Hide” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When Show/Hide is 

off, no markup is visible. 

Press the Show/Hide button 

to see the mark-up. 

 
 

Reveal Formatting Marks with Show/Hide 

Microsoft Word is a powerful application with many features and settings that 

control the layout of your document. On the surface, Word appears to work like 

magic, splitting pages, formatting paragraphs and shifting rows of text automatical- 

ly. However, Word has an underlying system of formatting marks that are normally 

invisible to the user that you can expose and use to assist in getting the right layout. 

The Show/Hide button allows you to view the hidden formatting marks embedded 

inside every document or template. These special marks are used by Word to control 

the way the text, paragraphs and pages flow. Once the format markup is visible, the 

document’s layout scheme becomes easy to modify as desired. Found on the Home 

tab, Paragraph section of the Microsoft Word toolbar, the Show/Hide button can be 
 

Tip: We strongly advise using “Show/Hide” to reveal formatting marks during 

the entire process of formatting your book using the template. 
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Mark-Up Symbols Decoded 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paragraph End (Pilcrow) 

This symbol shows the end of a paragraph or distinct segment of text. It is 

created by pressing the Enter      key one time. When formatting a document, 

the various formatting Styles utilize this symbol to demark a break. The following para- 

graph may be a different style or continue the previous one if you choose. 
 

 

Carriage Return / Line Break 

The carriage return symbol breaks a line of text and begins on the next line 

without breaking the paragraph or style. Created by pressing the 

Shift  +  Enter  keys,  the  carriage  return  is  useful  for  a  number  of formatting 

challenges, including adding spaces within a paragraph, adding a line of text that is 

not indented, and adding a new line to a style-controlled block. 
 

 

Tab 

Tab marks represent an indention created by pressing the Tab key. Tradi- 

tionally, tabs were utilized to indent the first line of a paragraph. In the pre- 

formatted Styles of the template, first line indents are controlled by the Styles, 

and are automatically created for the first line after a paragraph break. 

 

Tip: Carriage Returns are handy if you have a title or chapter name that is 

too long to fit on one line, allowing you to manually break the line. 
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Space 

Mark-up Symbols Decoded 

 

The small, height-centered dot represents a space between characters and 

is created by pressing the Spacebar. This is useful for aligning text and re- 

moving extra spaces from the document. 
 

 

 

Section Break (Odd Page) 

 
 

The Section Break (Odd Page) is the most common document break used when for- 

matting a book. Since chapters and most book segments start on the right-hand, or 

recto pages, a Section Break (Odd Page) at the completion of a chapter assures the 

next chapter starts where it should. Section Breaks can be created on the Page Layout 

under Breaks. 
 
 

Section Break (Next Page) 

 
 

Like the Section Break (Odd Page), the Section Break (Next Page) break will ensure a 

clean transition to the next physical page of the book. This is useful when you want to 

break a Title or other front matter page over to a verso, or left-hand page of the book., 

instead of a recto page like a chapter opening. 
 

Page Break 

 
 

Page Breaks demark the end of a page and force the next line of text to be on the next 

page. Section Breaks are preferred as they preserve formatting for documents that 

require pages to begin on verso or recto pages, like books. 
 

Tip: Page Breaks are used most often in illustrated children’s books, were im- 

ages and pages of text must be managed by hand. 
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Adding 

Photos & Images 
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Adding Images and Photos 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Inserting Images into your template can add life and a whole new range 

of possibilities to express your ideas. Since our templates can utilize the full 

feature set of Word, image embedding and formatting is an easy task. You 

may insert an image, resize it, reposition it and add captions as needed. 

 

Place your cursor on the page in the 

approximate location you wish to 

insert your image and click. 
 

 

Select Picture from the insert tab. 
 

 

 

Tip: We recommend inserting images 

from the toolbar, instead of using the 

“drag-and-drop” technique for placing 

images into your template document. 
 

 

Special Note: Inserting images into the Children’s Illustrated templates 

require special care. Instructions can be found in the “Children’s Template 

Feature Formatting” section of this guide. 
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Adding Images and Photos 
 

 

Your image will appear in the 

document on its own line of text, 

or, if it is a small image, in line with 

the chapter text. 
 

 

 

You may move the image by 

dragging it to a new location with 

your mouse. You may also resize the 

image by clicking it, and using the 

grey boxes on the image perimeter to 

resize the image. 
 

 

To wrap the text around the image, 

right click the image and choose the 

“Wrap Text” menu. Then select the ap- 

propriate style of word wrap. 
 

 

 

 

 

The text will automatically wrap 

around the image. 
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Adding Images and Photos 
 
 

You may caption the image by right- 

clicking on the image and selecting 

“Insert Caption” from the menu. 
 

 

 

 

 

 

You must label the caption. You may 

choose a pre-defined label, or create 

your own with the “New Label” 

button. 
 

 

 
 

Once you apply the label, you have 

the option of typing in a custom 

caption for your image by clicking the 

placeholder caption. 
 

 

 

 

You may adjust the caption’s size and 

position, as well as add more lines of 

text if needed. 
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eBook Image Tips 
 

 

Make sure images are in their own 

paragraph, with no text wrap applied. 
 
 

Use the center paragraph button to 

center the entire paragraph that the 

image resides in. 
 

 

For best results, images should have 

a width of 500 pixels or greater., at 

72ppi to fill the screen’s width. 

(1,500 pixels maximum ). 

(For picture book templates, there 

are special images size requirements) 
 

 

Do not use borders or lines around 

your image, as they will not translate 

correctly for most eBook platforms. 
 
 

Images should have crisp contrast and 

be bright enough to view on a variety 

of eReader devices, which may have a 

color or grayscale screen. 
 

Tip: Though we have high-contrast grayscale images in our sample here, you can also 

use color photos in your eBook files. Many newer eBook readers have sharp color 

screens that will display color images nicely. 
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Getting Ready for 

Print & Creating PDFs 
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Gutter Spacing 
 
 
 
 
 
 
 

Gutter Spacing is utilized to increase the inside margin of a book page to prevent the text from 

printing too close to the spine-fold of the book. Our templates include generous margins to meet 

most printing needs, however, longer works may require additional gutter margin spacing. 

 

Select the Margins drop down on the 

Page Layout tab in the Page Setup 

section. 
 

 

Choose Custom Margins. 
 

 

Add Additional Spacing in the 

Gutter section as needed. 
 

 

Choose Whole document in the Apply 

to drop down box. 
 
 

Click  OK. 
 

 

 

Tip: The default gutter spacing will accommodate up to 500 pages on most 

POD paper options. If you have a long work, are using thicker paper, or want 

larger margins, you should consult with your POD printer partner to 

determine an appropriate amount of gutter spacing. 
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Save to PDF 
 
 
 
 

 

PDF files are the most common type required by print-on-demand services due to their stand- 

ardized formatting and small size. Though there are many ways to export a Word document to a 

PDF, one of the most effective is to utilize Word’s built in “Save As PDF” functionality. 

 

 

 

Choose “Save As” from the “File” tab, 

or by pressing the “Office” button. 
 

 

Choose PDF from the “Save as type” 

drop down box. 
 

 

Click “Options”. 
 
 

Check “ISO 19005-1 compliant 

(PDF/A)” in the PDF options list if 

available. This will embed fonts and 

graphics into your PDF file. (Optional) 
 

Click “Save” 
 
 

Note: Always open the PDF to verify that it saved correctly. Some printers 

prefer non-PDF/A documents. Please follow your printer’s guidelines & speci- 

fications. Illustrated Children’s Book should not utilize the PDF/A Format. 

Some versions of Word for Mac require you to create a custom page size that 

matches your template’s trim size to save or print to PDF correctly. 
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Using Adobe Acrobat to Print a PDF 
Adobe Acrobat (XI or newer) is recommended to create the highest quality, 

highest resolution PDF documents for print. Adobe can be purchased from 

Adobe.com as a stand-alone product, or as part of the “Creative Cloud” package. 
 

Choose “Adobe PDF” as your printer 

from the “File / Print” tab, or by press- 

ing the “Print” button. 

 

Choose“Press Quality” from the 

“Default Setting” drop-down. 

Then choose “Edit”. 
 

Check “Embed all fonts” in the Fonts 

menu option. Press OK. (or cancel if it 

is already checked.) 

 

Select the final book trim-size in the 

Page size drop-down. Add the correct 

size if it is not in the list of options. 

 

Un-Check “Rely on system fonts”. 
 

Press“OK” and then Print. 
 

Note: MS Word’s PDF creation system has a limit of 220dpi. Though high- 

enough for razor sharp print for print-on-demand books, some vendor’s 

automated print check tools, like CreateSpace, may flag the PDF file as low- 

resolution. These book files typically print with superb quality. However, to 

achieve the maximum output resolution, creating your PDF with Adobe 

Acrobat will produce the highest resolution PDF files. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Getting Ready for 

eBook Conversion 

& Upload 
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eBook Template Tips 

Use Styles for Proper Layout 
 

 

 

 

 

 

eBooks also utilize Styles to control the layout of the document. Although fonts are often controlled 

by the eReader device, the size, position and other typographical features of the text will carry 

forward for the majority of eReader devices. This makes using styles a must for eBook templates. 

 

Use Section Breaks to End Chapters 
 

 

Books formatted for eReading devices utilize section breaks prior to a new chapter, just like their 

print formatted cousins. When an eBook is viewed on the eReader device, a section break will cause 

the next chapter to start at the top of the screen, preserving the flow one would expect in a book. 

 
 

Drop Cap Letters Should be Avoided 
 

 

 

 
 

Some print templates feature a drop cap letter at the chapter opening. Our eBook formatted 

templates omit these, as most eBook formats do not correctly render drop cap lettering. For the best 

results, avoid using drop caps in your eBook. 

 

 

Center Images in their Own Paragraph 
 

 

 

 

 

eBooks handle image insertion in a much different way than is native to Word, as most eBook formats 

are very similar to web-page in how they are encoded. To ensure that your images look right in your 

eBook, always place an image in its own paragraph, by using a carriage return before the image you 

insert.  Use Word’s center paragraph button to center an image if you desire.  Do not use word-wrap 

to attempt o wrap text around an image, as it is unlikely to translate to the eBook correctly. 
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eBook Template Tips 

Use only Template Specific Bullet Point Styles 
 

 

 

 

 

 

Most eBook formats do not support the built-in bullet points in Word. Our eBook specific templates 

have customized bullet point styles that include bullet points that will translate correctly to eBook 

formats as intended. These styles can be found under the Multilevel List section selection menu. 
 

Avoid Using Non-Standard or “Fancy” Fonts 
 

 

 

 
 

Few eReader formats will accept or embed fonts that are not installed on the device. Our eBook 

templates are designed to use a safe typeface that will be substituted by the eReader device’s own 

default font.  For best results, do not attempt to embed or utilize your own fonts for your eBook. 

Note: We use Times New Roman font, or similar, for all eBook templates to ensure maximum 

compatibility with as many devices as possible. 
 

Review and Follow Publisher Specific Guidelines Before Conversion 
 

 

 

 
 

Our eBook formatted templates are designed to be compatible with a wide array of eReader formats. 

However, eReader platforms are not universal and some may require additional adjustments to your 

document before conversion. We recommend that you read and follow your publisher’s specific 

guidelines prior to converting your eBook document to their platform. 
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Kindle Tips 
 
 
 
 
 
 
 
 

Our eBook ready templates are designed for Kindle right out of the box, so no special steps are 

needed to upload your book to the Kindle Direct Publishing website (KDP). Just be sure to follow our 

formatting tips for eBooks and for adding photos/images to eBooks to get the best results. 

 
NOTE: We recommend that you upload your eBook’s finished .DOCX file directly to KDP, and allow 

KDP to do the file conversion for your Kindle Edition. (You may also upload an ePub version.) 

 
 

Browse for your book’s .DOCX or .ePub 

file on your computer and select the 

file. 
 
 

Click Upload book. 
 

 

When the upload is complete, you will 

see the message, “Upload and conver- 

sion successful!” 
 

 
 

Preview your book and make 

changes as needed. 



 

Smashwords Tips 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Using our eBook ready templates for your Smashwords release is easy! Smashwords accepts ePub 

format book files, allowing you to bypass their meatgrinder. We recommend uploading ePub files. 

Smashwords has an incredibly detailed style guide that every author should read and understand to 

ensure maximum compatibility with their platform. For our templates, three specific steps need to be 

followed to make sure that your book complies with Smashwords’ formatting policies. 

 

 

You MUST add Smashwords’ Specific 

Copyright Language to the Copyright Page. 
 

 

 

 

 

 

 

Smashwords requires a small string of attribution after your copyright information. 

For the best results, replace the template’s copyright date line with the following formatted text. 

Book Title 

Author Name 

Copyright © 2018 by Author Name. 

Published at Smashwords 
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Smashwords Tips 
 

All Fonts Utilized Must be Below 18pts in Size 
 

 

 

 

 

 

 

 

 

 

 

 

 

Though many eBook formats accept larger font sizes, Smashwords encodes for a very wide range of 

devices and requires that all fonts be smaller than 18pts. Typically, only chapter headers or title text 

will be larger than 18pts. (You should always thoroughly review your book prior to submission.) 

To adjust the size, click on the title or chapter header text that is above 18pts. In the Word toolbar’s 

style section, the style controlling the title or chapter header you have selected will be highlighted. 

Right click the style and choose modify from the drop down menu. In the formatting section, lower 

the size to 18pts or lower. The style will update the text size and adjust your text accordingly. 
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Calibre eBook Conversion Tips 
 

Available for Free from: Calibre-eBook.com 
 

 

 

 

 

Calibre continues to be one of the top free eBook conversion applications available. Its simple to use 

interface and wide variety of formats from EPUB to MOBI make it an attractive tool for authors to use 

to convert their Word document into an eBook formatted file. 

 

 

Add the .DOCX or .DOC book file and Convert it 

 

 

 
 

Open Calibre and choose Add books from the menu at the top of the window. Find and choose 

the .doc or .docx version of the book file you saved in step one. The book will appear in the list of 

books in Calibre. Highlight your book and press the Convert books button to convert it to EPUB or 

other supported formats. 

 

You will have the option to add a cover and make other changes as needed. 
 

 

Save the File to Disk 

 

 

 

 
Once converted, the new file format version will show up in the list of formats in the right pane. You 

may right-click on the format and choose to delete the file, or save the file to disk for use elsewhere. 
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Licensing Requirements 
 
 

Q: Can I use the template on all my books? 

A: You can if you purchase a Multi-Book license. Our templates are copyrighted and licensed 

to individual authors, and we offer several licensing options to fit your needs and your budget. 

Q: What are the license options for using these templates? 

A: The Single-Book License is your choice if you’re an independent author who wants to cre- 

ate a beautiful book without spending a lot of money. This license entitles you to use the tem- 

plate for one of your own books at a very affordable price. The Multi-Book License will allow 

an indie author to use the same template to format several of his or her own books, or even a 

whole series, without having to buy a template license for each title. The Commercial License 

allows a sole proprietor who works as a designer or book shepherd helping other authors get 
to press. For a single fee, this license allows you to use the template for your own or other 

people's books. 

Q: What if I purchased a single-use license and want to utilize the same template for 

another book? 

A: You may purchase an unlimited-use upgrade license for the template. 

Q: What are the license requirements for the fonts included with the templates? 

A: Fonts supplied with our templates are Open Source or are licensed as free for commercial 

use and re-distribution. 

Q: If I heavily modify or customized the template I purchased, do I still have to register 

or license it? 

A: Yes. Any work that is developed, derived, formatted, or designed utilizing our template as 

a foundation is still considered under license for that template product and must be li- 

censed and registered. 

Q: Can I use the template for books I am creating for my clients/friends/wife? 

A: The commercial template license is available for commercial use. If you want to buy a cus- 

tom template design that you can use in your business or for clients, please contact us. 
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Support and More Information 
 
 
 
 

For more training guides and to download our 

Book Construction Blueprint 

Please visit: 

 
 

BookDesignTemplates.com/guides 
 

 

 

 
 

Have a question or need a little help? 

Please contact us at: 

 
 

support@bookdesigntemplates.com 
 

 
 

(We typically reply within three business days.) 

 

 

Also, please remember to check out our handy FAQ 

With answers to the most common Questions: 

 
 

BookDesignTemplates.com/faq 

mailto:support@bookdesigntemplates.com
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